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Abstract—These instructions give you guidelines for preparing papers for the EUI-Net Workshop. Use this document as a template if you are using Microsoft Word 6.0 or later. Otherwise, use this document as an instruction set. Instructions about final paper and figure submissions in this document are for the EUI-Net Workshop Proceedings, first of all, and the planned book later on; please use this document as a “template” to prepare your manuscript. For submission guidelines, follow instructions from the Workshop Secretariat as well as the Workshop web site (http://www.ier-nl.net/EUInet_Workshop.htm). Do not delete the blank line immediately above the abstract; it sets the footnote at the bottom of this column.

I. INTRODUCTION
T
HIS document is a template for Microsoft Word versions 6.0 or later. If you are reading a paper version of this document, please download the electronic file from the Workshop web site and save to MS Word templates directory. To create your own document, from within MS Word, open a new document using File | New then select paperformatinstructions.dot. All instructions are in this document. Instructions about final paper and figure submissions in this document are for the Workshop Proceedings; please use this document as a “template” to prepare your manuscript. For submission guidelines, follow instructions here or on the Workshop web site.
If your paper is intended for the EUI-Net Workshop, please contact the Workshop Secretariat concerning the format of your paper or explanation how to submit your paper in print ready form.

When you open paperformatinstructions.dot in Word on your PC or laptop, select “Page Layout” from the “View” menu in the menu bar (View | Page Layout), which allows you to see the footnotes. Then type over sections of the sample file, paperformatinstructions.dot or simply cut and paste from another document and then use markup styles. The pull-down style menu is at the left of the Formatting Toolbar at the top of your Word window (for example, the style at this point in the document is “Text”). Highlight a section that you want to designate with a certain style, then select the appropriate name on the style menu. The style will adjust your fonts and line spacing. Do not change the font sizes or line spacing to squeeze more text into a limited number of pages. Use italics for emphasis; do not underline. Do not ‘number’ your pages  in the document submitted electronically.

To insert images in Word, position the cursor at the insertion point and either use Insert | Picture | From File or copy the image to the Windows clipboard and then Edit | Paste Special | Picture (with “Float over text” unchecked). 

The EUI-Net working group concerned will do the final formatting of your paper. In principle there are no Workshop paper page limits. 

II. Procedure for Paper Submission

A. Review Stage

Instructions about final paper and figure submissions in this document are in this document; please use this document as a “template” to prepare your manuscript. For submission guidelines, follow instructions from the EUI-Net Workshop Secretariat or the Workshop website. Please submit your manuscript electronically. If you can only send in a hard copy, submit photocopies such that only one column appears per page. Send the number of copies specified by the Workshop Secretariat. If submitted electronically, you may submit your paper on disk, but you should nevertheless always submit your paper as an e-mail attachment also.

If you want to submit your file with one column electronically, please do the following:


--First, click on the View menu and choose Print Layout.


--Second, place your cursor in the first paragraph. Go to the Format menu, choose Columns, choose one column Layout, and choose “apply to whole document” from the dropdown menu.


--Third, click and drag the right margin bar to just over 4 inches in width.

The graphics will stay in the “second” column, but you can drag them to the first column. Make the graphic wider to push out any text that may try to fill in next to the graphic.

B. Final Stage

Instructions about final paper and figure submissions in this document are for the EUI-Net Workshop Proceedings; please use this document as a “template” to prepare your manuscript. For submission guidelines, follow instructions from the Workshop Secretariat as well as the Workshop web site. When you submit your final version, after your paper has been accepted, print it in two-column format, including figures and tables. Send, next to your electronic version, also a print of the paper; to the EUI-Net Workshop Secretariat. 

It is preferred to also send your final manuscript on a disk, which would help EUI-Net to prepare your paper for publication. Write the authors’ names on the disk label. If you are using a Macintosh, please save your file on a PC formatted disk, if possible. You may use Zip or CD-ROM disks for large files, or compress files using TAR..
Please, send also a sheet of paper with complete contact information for all authors. Include full mailing addresses, telephone numbers, fax numbers, and e-mail addresses. This information may be used for the further elaboration of the papers for the book. In addition, designate one author as the “corresponding author”. This is the author to whom proofs of the paper can be sent for the book publication. Proofs are sent to the corresponding author only.

C. Figures

All tables and figures will be processed as images. However, EUI-Net cannot extract the tables and figures embedded in your document. (The figures and tables you insert in your document are only to help you gauge the size of your paper, for the convenience of the referees, and to make it easy for you to distribute preprints). Therefore, submit, either (preferred) electronically as --.gif file -333dpi- or --.jpeg file -333dpi- or  as a --.pdf file, or (less preferred) on separate sheets of paper, enlarged versions of the tables and figures that appear in your document. These are the images EUI-Net will (scan and) publish with your paper.  The above example shows how bad else a figure might appear in your paper.

D. Electronic Image Files (Preferred)

You will have the greatest control over the appearance of your figures if you are able to prepare electronic image files. If you do not have the required computer skills, just submit paper prints as described above and skip this section.

1) Easiest Way: If you have a scanner, the best and quickest way to prepare non-colour figure files is to print your tables and figures on paper exactly as you want them to appear, scan them with a high resolution (300 dpi or higher), and then save them to a file in JPEG (jpg) or GIF (gif) formats. Use a separate file for each image. File names should be of the form “fig1.gif” or “fig2.jpg”.

2) Slightly Harder Way: Using a scanner as above, save the images in TIFF format. High-contrast line figures and tables should be prepared with 600 dpi resolution and saved with no compression, 1 bit per pixel (monochrome), with file names of the form “fig3.tif” or “table1.tif”. To obtain a 3.45-in figure (one-column width) at 600 dpi, the figure requires a horizontal size of 2070 pixels (600 x 3.45). Typical file sizes will be on the order of 0.5 MB.
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Photographs and grayscale figures should be prepared with 300 dpi resolution and saved with no compression, 8 bits per pixel (grayscale). To obtain a 3.45-in figure (one-column width) at 300 dpi, the figure should have a horizontal size of 1035 pixels (300 x 3.45). 

Color figures should be preferably prepared with 400 dpi resolution and saved with no compression, 8 bits per pixel (palette or 256 color). To obtain a 3.45-in figure (one column width) at 400 dpi, the figure should have a horizontal size of 1380 pixels (400 x 3.45). 

For more information on TIFF files, please visit the Internet at the sites concerned.

3) Somewhat Harder Way: If you do not have a scanner, you may create non-colour PostScript figures by “printing” them to files. First, download a PostScript printer driver from http://www.adobe.com/support/downloads/pdrvwin.htm
(for Windows) or from

http://www.adobe.com/support/downloads/pdrvmac.htm
(for Macintosh) and install the “Generic PostScript Printer” definition. In Word, paste your figure into a new document. Print to a file using the PostScript printer driver. File names should be of the form “fig5.ps”. Use Adobe Type 1 fonts when creating your figures, if possible. 

4) Other Ways: Experienced computer users can convert figures and tables from their original format to TIFF. Some useful image converters are Adobe Photoshop, Corel Draw, and Microsoft Photo Editor, an application that is part of Microsoft Office 97 and Office 2000 (look for C:\Program Files\Common Files \Microsoft Shared\ PhotoEd\ PHOTOED.EXE. (You may have to custom-install Photo Editor from your original Office disk.)

Here is a way to make TIFF image files of tables. First, create your table in Word. Use horizontal lines but no vertical lines. Hide gridlines (Table | Hide Gridlines). Spell check the table to remove any red underlines that indicate spelling errors. Adjust magnification (View | Zoom) such that you can view the entire table at maximum area when you select View | Full Screen. Move the cursor so that it is out of the way. Press “Print Screen” on your keyboard; this copies the screen image to the Windows clipboard. Open Microsoft Photo Editor and click Edit | Paste as New Image. Crop the table image (click Select button; select the part you want, then Image | Crop). Adjust the properties of the image (File | Properties) to monochrome (1 bit) and 600 pixels per inch. Resize the image (Image | Resize) to a width of 3.45 inches. Save the file (File | Save As) in TIFF with no compression (click “More” button). 

Most graphing programmes allow you to save graphs in TIFF; however, you often have no control over compression or number of bits per pixel. You should open these image files in a programme such as Microsoft Photo Editor and re-save them using no compression, either 1 or 8 bits, and either 600 or 300 dpi resolution (File | Properties; Image | Resize). See Section II-D2 for an explanation of number of bits and resolution. If your graphing programme cannot export to TIFF, you can use the same technique described for tables in the previous paragraph.

A way to convert a figure from Windows Metafile (WMF) to TIFF is to paste it into Microsoft PowerPoint, save it in JPG format, open it with Microsoft Photo Editor or similar converter, and re-save it as TIFF.

Microsoft Excel allows you to save spreadsheet charts in Graphics Interchange Format (GIF). To get good resolution, make the Excel charts very large. Then use the “Save as HTML” feature (see http://support.microsoft. com/support/kb/articles/q158/0/79.asp). You can then convert from GIF to TIFF using Microsoft Photo Editor, for example.

No matter how you convert your images, it is a good idea to print the TIFF files to make sure nothing was lost in the conversion. 

If you modify this document for use with other journals or conferences, it is recommended you should save it as type “Word 97-2000 & 6.0/95 - RTF (*.doc)” so that it can be opened by any version of Word.
E. Copyright Form

An EUI-Net copyright form should accompany your final submission. These are available at the Workshop web site. Authors are responsible for obtaining any security clearances.

III. Helpful Hints

A. Figures and Tables

Instructions about final paper and figure submissions in this document are for the EUI-Net Workshop Proceedings; please use this document as a “template” to prepare your manuscript. For submission guidelines, follow instructions of the Workshop Secretariat as well as the Conference website. Because EUI-Net will do the final formatting of your paper, you do not need to position figures and tables at the top and bottom of each column. In fact, all figures, figure captions, and tables can be at the end of the paper. However, if you want to have a figure or a table, etc. at a definite place in your paper, you should already place them on the right spot. Large figures and tables may span both columns. Place figure captions below the figures; place table titles above the tables. If your figure has two parts, include the labels “(a)” and “(b)” as part of the artwork. Please verify that the figures and tables you mention in the text actually exist. Please do not include captions as part of the figures. Do not put captions in “text boxes” linked to the figures. Do not put borders around the outside of your figures. Use the abbreviation “Fig.” even at the beginning of a sentence. Do not abbreviate “Table”. Tables are numbered with Roman numerals. 

Colour printing of figures is available, but the quality of the printing will never be guaranteed. Include a note with your final paper indicating that you request colour printing. Do not use colour unless it is necessary for the proper interpretation of your figures. 

Figure axis labels are often a source of confusion. Use words rather than symbols. As an example, write the quantity “Years of Teaching”, or “Teaching Years”, not just “T” or “Y’ or “TY”. Put units in parentheses. Do not label axes only with units. As in Fig. 1, for example, write “Teaching” or “Teaching (T)”, not just “T”. Do not label axes with a ratio of quantities and units. For example, write “Research (R)”, not “Research/R”. 

Multipliers can be especially confusing. Write “Synergy (R/T)” or “Synergy (2R/T)”. Do not write “Synergy (R/T) ( 2” because the reader would not know whether the top axis label in Fig. 1 meant 2 R/T or 0.5 R/T. Figure labels should be legible, approximately 8 to 12 point type.

B. References

Number citations consecutively in square brackets [1]. The sentence punctuation follows the brackets [2]. Multiple references [2], [3] are each numbered with separate brackets [1]–[3]. When citing a section in a book, please give the relevant page numbers [2]. In sentences, refer simply to the reference number, as in [3]. Do not use “Ref. [3]” or “reference [3]” except at the beginning of a sentence: “Reference [3] shows ... ”. Unfortunately the EUI-Net document translator cannot handle automatic endnotes in Word; therefore, type the reference list at the end of the paper using the “References” style.

Number footnotes separately in superscripts (Insert | Footnote).
 Place the actual footnote at the bottom of the column in which it is cited; do not put footnotes in the reference list (endnotes). Use letters for table footnotes (see Table I). 

Please note that the references at the end of this document are in the preferred referencing style. Give all authors’ names; do not use “et al.” Use a space after authors' initials. Papers that have not been published should be cited as “unpublished” [4]. Papers that have been submitted for publication should be cited as “submitted for publication” [5]. Papers that have been accepted for publication, but not yet specified for an issue should be cited as “to be published” [6]. Please give affiliations and addresses for private communications [7].

Capitalize only the first word in a paper title, except for proper nouns and element symbols. If you are short of space, you may omit paper titles. However, paper titles are helpful to your readers and are strongly recommended. For papers published in translation journals, please give the English citation first, followed by the original foreign-language citation [8].

C. Abbreviations and Acronyms

Define abbreviations and acronyms the first time they are used in the text, even after they have already been defined in the abstract. Abbreviations such as EUI-Net, EU, UK, and U.K. or acronyms such as SOCRATES or ERASMUS do not have to be defined. Abbreviations that incorporate periods should not have spaces: write “C.N.R.S.”, not “C. N. R. S.” Do not use abbreviations in the title unless they are unavoidable (for example, “EUI-Net” in the title of this article, but which is, as a name of its own by now, the only acceptable exception).

D. Other Recommendations

Use one space after periods and colons. Hyphenate complex modifiers: “zero-field-horizontal teaching.” Avoid dangling participles, such as, “Using (1), the output was obtained.” [It is not clear who or what used (1).] Write instead, “The output was obtained by using (1)”, or “Using (1), we obtained the outcome”, but the best is to avoid sentences as these at all.

Use a zero before decimal points: “0.25”, not “.25”. Use “cm3”, not “cc”. Indicate sample dimensions as “0.1 cm ( 0.2 cm”, not “0.1 ( 0.2 cm2”. The abbreviation for “seconds” is “s”, not “sec”. Do not mix complete spellings and abbreviations of units: use “R/m2” or (better) “researchers per square meter”, not “researchers/m2”. When expressing a range of values, write “7 to 9” or “7-9”, not “7~9”.

A parenthetical statement at the end of a sentence is punctuated outside of the closing parenthesis (like this). (A parenthetical sentence is punctuated within the parentheses.) In Euro English, periods and commas are outside quotation marks, like “this period”. Other punctuation is also “outside”! Avoid contractions; for example, write “do not” instead of “don’t”. The serial comma is preferred: “A, B, and C” instead of “A, B and C”. If a dot has to be placed after an abbreviation and a closing parenthesis follows, than do not repeat the dot to indicate the end of the sentence. 

If you wish, you may write in the first person singular or plural and use the active voice (“I observed that ...” or “We observed that ...” instead of “It was observed that ...”). Remember to check spelling. If your native language is not English, please get a native English-speaking colleague to proofread your paper. In the end you are your self responsible for the text and its correct (Euro English / British English) spelling.

IV. Some Common Mistakes

The word “data” is plural, not singular. The (sub)script for the synergy result is zero, not a lowercase letter “o”. A graph within a graph is an “inset”, not an “insert”. The word “alternatively” is preferred to the word “alternately” (unless you really mean something that alternates). Use the word “whereas” instead of “while” (unless you really are referring to simultaneous events). Do not use the word “essentially” to mean “approximately” or “effectively”. Do not use the word “issue” as a euphemism for “problem”. 

Be aware of the different meanings of the homophones “affect” (usually a verb) and “effect” (usually a noun), “complement” and “compliment”, “discreet” and “discrete”, “principal” (e.g., “principal investigator”) and “principle” (e.g., “principle of measurement”). Do not confuse “imply” and “infer”. 

Prefixes such as “non”, “sub”, “micro”, “multi”, and “ultra” are not independent words; they should be joined to the words they modify, usually without a hyphen. There is no period after the “et” in the Latin abbreviation “et al.” (it is also italicized). The abbreviation “i.e.”, means “that is”, and the abbreviation “e.g.”, means “for example” (these abbreviations are not italicized).

An excellent style manual and source of information for science writers is [9]. 

V. Editorial Policy

Submission of a manuscript is not required for participation in a conference. Do rather not submit a reworked version of a paper you have submitted or published elsewhere. Do not publish “preliminary” data or results. The submitting author is responsible for obtaining agreement of all coauthors and any consent required from sponsors before submitting a paper. It is the obligation of the authors to cite relevant prior work.

EUI-Net does intend to publish conference proceedings. EUI-Net does publish the papers that have been recommended for publication on the basis of peer review. As a matter of convenience and service to the community, these papers are collected and also published in a separate book

At one reviews is required for every paper submitted. The decision to accept or reject a paper is made by the Organising Committee on base of the advices given by the Scientific Committee; the recommendations of the referees are advisory only. Undecipherable English is a valid reason for rejection. Authors of rejected papers may revise and resubmit them as contribution to the book, whereupon they will be reviewed by two new referees.

VI. Publication Principles

The contents of the EUI-Net Proceedings are of responsibility of the authors of the papers concerned. Authors should consider the following points:

1) Papers submitted for publication must mirror the state of knowledge the subject concerned and must cite relevant prior work. 

2) The length of a submitted paper should be commensurate with the importance, or appropriate to the complexity, of the work. For example, an obvious extension of previously published work might not be appropriate for publication or might be adequately treated in just a few pages.

3) Authors must convince readers of the relevance and merit of a paper; the standards of proof are higher when extraordinary or unexpected results are reported. 

4) Because replication is required for public knowledge progress, papers submitted for publication must provide sufficient information to allow readers to understand and have the possibility to perform similar experiments or obtain equal experiences and use the reported results. Although not everything need be disclosed, a paper must preferably contain also some new, useable, and fully described information. For example, a well known classroom- or common research practice experience need not be reported at full length if the main purpose of a paper is to introduce a new or another experience. Authors should expect to be challenged by reviewers if the results are not supported by adequate data and critical details.

VII. Conclusion

A conclusion section is not required. Although a conclusion may review the main points of the paper, do not replicate the abstract as the conclusion. A conclusion might elaborate on the importance of the work or suggest applications or further elaborations. 

Appendix

Appendixes, if needed, appear before the acknowledge-ment.

Acknowledgement

The preferred spelling of the word “acknowledgement” in Euro English is with an “e” after the “g.” Use the singular heading even if you have many acknowledgements. Avoid expressions such as “One of us (A.A.) would like to thank ... .” Instead, write “A. Author thanks ... .” Sponsor and financial support acknowledgments are placed in the unnumbered footnote on the first page.
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Fig. 1.  Research growing interest as a function of applied teaching. Note that “Fig.” is abbreviated. There is a period after the figure number, followed by two spaces. It is good practice to explain the significance of the figure in the caption.
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�It is recommended that footnotes be avoided (except for the unnumbered footnote with the receipt date on the first page). Instead, try to integrate the footnote information into the text. Neither use ‘headers’ and ‘footers’ or another page (number) identifications.





